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1 FiRECAM EXPERT OPTIONS AND DATA

WARNING

THESE OPTIONS ARE TO BE USED BY EXPERIENCED FiRECAM USERS AND THE FIRE
RISK MANAGEMENT PROGRAM FOR VERIFICATION AND TESTING PURPOSES.  IT IS
INCLUDED FOR COMPLETENESS, BUT THE FIRE RISK MANAGEMENT PROGRAM
CANNOT ASSUME RESPONSIBILITY OR BE HELD LIABLE FOR IMPROPER USE AND
MODIFICATION OF THE FiRECAM EXPERT OPTIONS.

FiRECAM allows users to access additional input file data under its Expert Mode.  Expert mode
allows the user to modify seldom-modified statistical data in the following categories:

•  Climate and Location

•  Building Occupant Response and Action Statistics

•  Fire Spread and Failure Statistics

•  Numerical Control

•  Fire Department Characteristics

Choosing Program Options under the FiRECAM Options Menu, as in Figure 1-1, allows a
user to enter Expert mode by displaying the File Options tabbed dialog.

Figure 1-1. The Options Menu

Once the Expert Options item is chosen, the user then chooses the Expert Program Options
tree node, as in Figure 1-2.

Figure 1-2. FiRECAM Program Options - Program Options
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Table 1-1. Expert Mode Options.

Expert Options

FiRECAM Expert Program Options
Prompt for Expert
Password at Startup

This option controls whether FiRECAM will prompt,
when started, for an expert password, as shown below:

If the user enters a valid user name and password, the
expert menus and toolbar will be enabled. For a full
description of Expert Mode and the Expert Database,
see the FiRECAM Expert Data Appendices.

Expert Mode can also be entered by clicking the
Expert… button on the upper right hand side of the File
Options form (see Figure 1-2).

Verify Input File Integrity
when Opened

When a FiRECAM input file is opened, its integrity will
be checked; all sections of the input file are properly
formatted.  If there are any errors in the file, or the file is
corrupt, FiRECAM will display an error message, and will
not attempt to open the file.

Verify FiRECAM Startup
Files

When FiRECAM first starts, runtime files, such as the
fire growth and climate databases, will be checked.  If
any of these runtime files are missing or corrupt,
FiRECAM will first try to repair these files.  If the repair
procedure is unsuccessful, FiRECAM will display an
error message.

NOTE: This option, when selected, will slow down
startup time.



EXPERT TOOLS AND OPTIONS MANUAL

1-3

Table 1-1 Continued

Expert Options

FiRECAM Expert Output Options
Create Debugging Model
Linkage File

When this option is checked, FiRECAM will, during a
run:

•  Create a run dump file

•  Copy the contents of the FiRECAM initialization file
(FIRECAM.INI)

•  Copy the contents of the FiRECAM input file that is
being run

•  Copy the contents of each FiRECAM temporary file
at the end of executing a scenario

•  Copy the time and date of the run.

This file will retain the same base file name of the input
file, but with the extension DUM.  For example, if the
input file is named

CASE1.FCI

The dump file will be named

CASE1.DUM

This file is used to help in debugging FiRECAM and will
be used for technical support.  A typical FiRECAM dump
file is shown in Listing 1-1.

Create Debugging Action
Log File

When this option is enabled, FiRECAM will create an
error logging file (by default) called ACTION.LOG, which
will list the actions performed as FiRECAM executes,
user interactions and runtime error messages.  This file
is used primarily for technical support and error
debugging and summarizes all the calculations
performed by FiRECAM; the user’s input actions, and
any warning and error messages.  A typical log file is
listed in Listing 1-2.  Some of the contents of this file
are:

•  Computer Information

•  FiRECAM Startup

•  Copy of FiRECAM Input File

•  Dialog Box Invocations

•  Model Execution

•  Run Time Errors
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Figure 1-3. FiRECAM Program Options - Expert Database Options

Table 1-2. Expert Database Updating Options

Expert Options

Expert Database Updating
Expert Database Updating
Options

When Expert Data has been modified in a user file,
update the Master Expert database…

•  Never

The Master Expert Data will never be updated to reflect
any changes done to the user file’s expert sections.

•  Prompt User

The user will be prompted to apply changes to the
Master Expert Data after the user’s expert data has
changed.

•  Always

The Master Expert Data will always be updated to reflect
any changes done to the user file’s expert sections.  The
user will not be prompted to apply the changes.
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Table 1-2 Continued

Expert Options

Expert Database Updating
Expert Database Updating
on Saving File

When the Master Expert Database has been modified,
update newly opened user files…

•  Never

The user file will never be updated to reflect any
changes done to the Master Expert Database.

•  Prompt User

The user will be prompted to apply changes if the
Master Expert Database has changed.

•  Always

The user file’s Expert Data will always be updated to
reflect any changes done to the Master Expert
Database. The user will not be prompted to apply the
changes.
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When the user clicks the Expert… button, FiRECAM will prompt for a user name and a
password.  This user name/password feature is used to prevent casual and accidental
modification of FiRECAM’s Expert database.  For a full description of FiRECAM Expert
passwords, and the FiREPASS Expert Password Utility, refer to Appendix B, "FiRECAM
EXPERT PASSWORD UTILITY”

Figure 1-4. FiRECAM Expert Password Prompting Input Box

When Expert Mode is entered, open FiRECAM input files will display an expanded tree view, as

shown below in Figure 1-5. The new Expert Data tree root  at the bottom of the tree node list
allows the inspection of all the file’s expert data entries.  For a complete description of the
Expert Data see  Section 1.1,”FiRECAM Expert Options”.

Figure 1-5. Typical FiRECAM Input File Data Tree Showing Expanded Expert Node
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Listing 1-1. Typical FiRECAM Dump File Fragment

======================================================================
======================================================================

FiRECAM Version : 0.09.00
Free Memory (KB) : 84630
Free User Resources : 90
Free GDI Resources : 90
DOS Version : 5.00
Windows Version : 3.10
Windows Mode : Enhanced
CPU Type : 486
Math Coprocessor : Present
Video Driver : VGA
Video Resolution : 1280 x 1024
Colors : 256
Mouse : Microsoft, or IBM PS/2
Network : LAN Support
Language : English (American)
Keyboard : Enhanced 101 or 102 key US and Non US keyboards

======================================================================
======================================================================

======================================================================
File Name : FiRECAM.INI
======================================================================

[PassWords]
t=A3D6FA917FE81105

[Units]
Units=2

[Debug]
DefaultModelSelection=32767
DefaultScenarioSelection=63

[Program Directories]
NewFileInitOption=0
ProgramTEMPLocation=0
ProgramREPORTLocation=0
NewFileInitFileName=FiRECAM.MAS
ProgramREPORTDir=REPORTS

[Logo]
DisplayToolBar=-1
DisplayLogoAtStart=2
DefaultEditWindowPosition=5
ToolBar1=-0000001+0000000+0000000+0000000+0001755+0000000+0000000
ToolBar3=+0000000+0000000+0000000+0000000+0000720+0000000+0000000

[New Files]
FinalFileOption=207

[Monitor]
ExecutionMonitor=519

[Recent Files]
RecentFile1=E:\PROJECTS\FIRECAM\PWC2_1.FCI
RecentFile2=E:\PROJECTS\FIRECAM\CBC_1.FCI
RecentFile3=E:\PROJECTS\FIRECAM\PWC2_1.FCI
RecentFile4=E:\PROJECTS\FIRECAM\CBC_1.FCI
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Listing 1-2 displays a typical log file after a run in FiRECAM when the Create Debugging
Action Log File item is checked.

Listing 1-2. Section of a Typical FiRECAM Log File Fragment

================================================================================
FIRECAM.LOG
LOG FILE CREATED ON Wednesday, April 16, 1997

FiRECAM Version : 0.09.00
Free Memory (KB) : 87831
Free User Resources : 90
Free GDI Resources : 90
DOS Version : 5.00
Windows Version : 3.10
Windows Mode : Enhanced

CPU Type : 486
Math Coprocessor : Present
Video Driver : VGA
Video Resolution : 1280 x 1024
Colors : 256

================================================================================
LOG ENTRY : 0 4/16/97 Reading FIRECAM.INI...

.

.

.
LOG ENTRY : 0 4/16/97 DONE !!!
================================================================================
LOG FILE CLOSED ON Wednesday, April 16, 1997
================================================================================
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1.1 FiRECAM Expert Menu

When Expert Mode is active, FiRECAM displays

•  The FiRECAM Expert menu

•  An Expert Data tree view item that provides access to the expert data categories.

The FiRECAM Expert Menu debugging options (see Figure 1-6) are discussed in detail in
Chapter 4, “FiRECAM Expert Debugging Options”.

Figure 1-6. The FiRECAM Expert Menu

Figure 1-7 below shows a typical FiRECAM input file screen with the Expert Data tree root
visible. By clicking on the ‘+’ sign to the left of the Expert Data tree item, the user will expand
the tree to view all the available data categories, as ahown below.

Figure 1-7. Expert Data Tree Root – Expanded View with Node Legends

Expert Data Root

Climate and Location Data

Fire Statistical Data

Occupant Statistical Data

Fire Department Statistical Data

Numerical Data
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1.2 Editing FiRECAM’s Master Expert Database

In order to understand FiRECAM’ expert data, it is important to note that the expert data for an
input file is stored in two locations:

•  A local copy in the Expert section of a FiRECAM input file

When a FiRECAM input file is saved, a copy of the Expert data (derived from the file
FIRECAM.MBS, the master copy of the expert data file section) is appended to the end of
the file.  When the file is opened at a later date, the file's local copy of the expert data is
used, and it is this local copy that can be edited and modified by the user.  The second
location of the master data, described below, is not touched, except by selecting automatic
options.  These updating options are described below as well.

Expert Input Section

User Input Section

Expert Input Section
(Local Copy)

User Input Section

FiRECAM Data File
(merged)

Expert Data
Input Screens

•  A master copy of the data in FiRECAM’s master Expert Database (FIRECAM.MBS)

FiRECAM also keeps a copy of the Master Expert data in a file called FIRECAM.MBS.
When a new file is created using one of the wizard or templates, a copy of this master
expert data is appended to the end of the new file to create its local copy, or instance, of
expert data.

Expert Input Section
(Local Copy)

User Input Section

Master Expert Input
Section Copy

(FiRECAM.MBS)

User Input Section

New FiRECAM Data File
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When a user saves a file after modifying any of the expert data, the master copy of the expert
data can be updated to reflect the changes by a choice of three options (as set in the Expert
file options menu):

•  Never

The Master Expert Data will never be updated to reflect any changes done to the user file’s
expert sections.  This is useful when the master expert data file should never be modified,
as in setting to a reference file for a particular location.

•  Prompt User

 The user will be prompted to apply changes to the Master Expert Data after the user’s
expert data has changed, as shown below:

•  Always

 The Master Expert Data will always be updated to reflect any changes done to the user file’s
expert sections.

Master Expert Input
Section Data

(FiRECAM.MBS)

Expert Input Section
(Local Copy)

Expert Data
Saving Options

FiRECAM also allows a user to directly modify FiRECAM’s master expert database.  By
selecting Edit FiRECAM’s Master Expert Data from the Expert menu, as shown below, a
special dialog with an Expert tree will appear, as in Figure 1-8.

Figure 1-8. FiRECAM Expert Menu – Edit Master Expert Data

Figure 1-9. Master Expert Tree View Root



EXPERT TOOLS AND OPTIONS MANUAL

1-12

Figure 1-10 shows the master Expert data tree root expanded to the first level.  The main first
level categories are

•  Climate Data

•  Fire Department Data

•  Numerical Control

Two additional first level categories:

•  Apartment Occupancy, and

•  Office Occupancy

are used to display and modify data that applies to these specific occupancy types.

Data specific to occupancy types are:

•  Fire Statistics

•  Occupant Statistics

•  Expert Report

Figure 1-11 shows the Fire Department root expanded, and Figure 1-12 shows the Apartment
and Office occupancy nodes expanded.  The descriptions of the data falling under these
categories are described later in this section, starting with Section 1.3, “FiRECAM Climate and
Location Data”

Figure 1-10. Master Expert Tree View – First Level Expanded

Figure 1-11. Master Expert Tree View – Fire Department Node Expanded
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Figure 1-12. Master Expert Tree View – Occupancy Type and Report Nodes Expanded



EXPERT TOOLS AND OPTIONS MANUAL

1-14

1.3 FiRECAM Climate and Location Data

When the user clicks the Climate item (see Figure 1-13 below), a dialog box showing the
contents of the climate database will appear.

Figure 1-13. Expert View - Climate Database

The Climate database is displayed as an Access compatible grid of data containing the city or
region name, and its associated temperatures for each month.  A typical view of the climate
database contents is shown below, in Figure 1-14 and explained in Table 1-3.

Figure 1-14. Climate and Location Input Dialog Box
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Table 1-3. Climate and Location Database Contents

Climate and Location Database

Climate Data Influences
Location

The location of the building, usually as a city and
province (or country).

Maximum Temperature
Minimum Temperature

The maximum and minimum expected temperatures for
each month of the year, expressed in °C for the
corresponding above location.

•  Smoke Spread
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1.4 FiRECAM Occupant Response Data

When the user clicks the Occupants item (see Figure 1-15 below), a dialog box showing the
contents of the occupant response database will appear.

Figure 1-15. Expert View - Occupants

The Occupants item (see Figure 1-15) allows the user to inspect data relating to the
occupants’ responses during a fire. The main responses are:

•  Occupant Perception

•  Occupant Action

•  Interpretation Times

•  Travel Speeds

Table 1-4 summarizes the occupant response perception and action probabilities.
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1.4.1 Occupant Perception and Action Probabilities

Expert data on Occupant Perception and Action Probabilities can be found in the Perception
and Action tab, as shown in Figure 1-16 below.

Figure 1-16. Occupant Response Input Dialog Box - Perception and Action Tab

Table 1-4 summarizes the data items found on this tab.

Table 1-4. Occupant Response Perception and Action Probabilities

Occupant Response Data

Occupant Perception Probabilities Influences
Occupant Perception Probabilities per Time Frame

The probability that a building occupant will directly
perceive a fire incident due to fire cues (sight, smell, and
sound) in a given time frame.

Values are listed for the following Time Frames:

•  Time Frames 0 to 5

•  Occupant Response

•  Occupant Evacuation

•  Fire Department
Response
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Table 1-4 Continued

Occupant Response Data

Occupant Action Probabilities Influences
Perception Types:

•  Direct Perception

•  Warning from Fire Department

•  Warning from Occupants

•  Warning from Voice Alarm System

•  Warning from Central Alarm System

•  Warning from Local Smoke Alarm

The probability that a building occupant after any of the
following perceptions, given that he has:

•  directly perceived a fire event,

•  received a fire event warning from the fire
department after it has arrived at the site

•  received a fire event warning from other building
occupants

•  received a fire event warning from a central alarm
system with voice communication systems

•  received a fire event warning from a central alarm
system

•  received a fire event warning from a local self-
contained smoke detector

will perform any of the following actions.

•  Warning Fire Compartment Occupants

•  Warning Fire Floor Occupants

•  Warning Other Floor Occupants

•  Activating a Pull Bar

•  Occupant Response

•  Occupant Evacuation
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1.4.2 Occupant Interpretation and Travel Speeds

Expert data on Interpretation Times and Travel Speeds can be found in the Interpretation and
Travel tab, as shown in Figure 1-17 below.

Figure 1-17. Occupant Response Input Dialog Box - Interpretation and Travel Tab

Table 1-5 summarizes the occupant response interpretation times and travel speeds.

Table 1-5. Occupant Response Interpretation and Travel Speed Data

Occupant Response Data

Probability of Calling Fire Department Influences
Location of occupants:

•  Fire Compartment Occupants

•  Fire Floor Occupants

•  Other Floor Occupants

The probability that occupants

•  in the compartment of fire origin,

•  on the floor of fire origin, and

•  on the floors other than the floor of fire origin

will call the fire department after perceiving a fire or
receiving a fire warning from fire cue, local or central
alarm.

•  Occupant Response

•  Occupant Evacuation

•  Fire Department Action
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Table 1-5 Continued

Occupant Response Data

Perception to Action Delay Times Influences
Delay times for:

•  High Probability

•  Medium Probability

•  Little Probability

The time delay in seconds between the instant the
occupant perceives an event relating to a fire, and the
instant that the occupant decides to act on that event,
given a high, medium or low probability of action by the
occupant.

•  Occupant Response

•  Occupant Evacuation

Occupant Travel Speeds Influences
Emergency Speeds:

•  Horizontal Distances

•  Up Stairs

•  Down Stairs

Normal Speeds:

•  Horizontal Distances

•  Up Stairs

•  Down Stairs

The travel speeds assumed by the occupants when
traveling during emergency and normal conditions for
horizontal, up stairs and down stairs, in
meters/second.

Values for:

•  Men

•  Women

•  Children, Seniors, Families

•  People with Special Needs

•  Occupant Evacuation
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1.5 FiRECAM Fire and Alarm System Components Statistics

The Statistics node of the Expert Data Tree root includes data for three areas:

•  Smoke Control

•  Reliability

•  Barrier Failure

•  Fire Statistics

These are shown in Figure 1-18.

Figure 1-18. Expert View - Statistics
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1.5.1 Smoke Control Statistics

Expert data on detectors, sensors, smoke control and sprinklers can be found in the Smoke
Control tab, as shown in Figure 1-19 and explained in Table 1-6 below.

Figure 1-19. Fire and Alarm System Input Dialog Box - Smoke Control Tab

Table 1-6. Statistical Data - Smoke Control Data

Fire and Alarm System Statistical Data

Probabilities of Door(s) Being Left Open Influences
Door locations:

•  Fire Compartment to Corridor

•  Corridor to Stair Shaft

•  Corridor to Non-fire Compartments on Fire Floor

The probability that the doors leading from:

•  a fire origin compartment to a corridor

•  a corridor to a stair shaft

•  a corridor to compartments on the fire origin floor,
other than the fire origin compartment

will be left open when a fire starts.

•  Smoke Spread

•  Fire Spread Failure
Probabilities

•  Expected Risk to Life
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Table 1-6 Continued

Fire and Alarm System Statistical Data

Smoke Control Systems Influences
Smoke Ventilation System

The probability that an installed smoke ventilation
system is effective.

Stair Pressurization System

The probability that an installed stair pressurization
system is effective.

•  Smoke Spread
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1.5.2 System Reliability

Figure 1-20. Fire and Alarm System Input Dialog Box – System Reliability Tab

Table 1-7. Statistical Data – System Reliability Data

Fire and Alarm System Statistical Data

Suppression Systems Reliability Influences
Reliability

The reliability of an automatic suppression (sprinkler)
system, expressed as the probability that the sprinkler
system will activate during a fire, given that a fire occurs.

•  Design Fire
Occurrence Probability

Suppression Effectiveness

The probability that an automatic suppression (sprinkler)
system, once activated, will actually suppress a fire.

•  Design Fire
Occurrence Probability

•  Occupant Response

•  Fire Department Action
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Table 1-7 Continued

Fire and Alarm System Statistical Data

Detector Reliability Influences
Local Smoke Alarm

The reliability of a local smoke detector alarm,
expressed as the probability that the local smoke alarm
will activate during a fire, given that a fire occurs.

Smoke Detector

The reliability of a central alarm smoke detector,
expressed as the probability that the smoke detector will
activate during a fire, given that a fire occurs.

Heat Detector

The reliability of a central alarm heat detector,
expressed as the probability that the heat detector will
activate during a fire, given that a fire occurs.

Central Alarm System

The reliability of a central alarm system control panel,
expressed as the probability that the alarm system will
function after receiving signals from detectors.

•  Occupant Response

•  Fire Department
Response and Action
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1.5.3 Barrier Failure Probabilities

Figure 1-21. Fire and Alarm System Input Dialog Box – Barrier Failure Tab

Table 1-8. Fire and Alarm System Statistical Data –Barrier Failure Probabilities

Fire and Alarm System Statistical Data

Barrier Failure Probabilities Influences
Barrier failures for the following stair directions:

•  Open Stairs to Open Stairs (up)

•  Open Stairs to Open Stairs (down)

The probability that any barriers between floors in the
stairwells will fail in the

•  upward direction

•  downward direction

when exposed to a flashover fire.

•  Fire Spread

Barrier Failure Probability Correction Factors Influences
Factor for Inadvertent Openings of Wall and Floor

Acceleration factor used for computing the probability
that a wall or floor barrier will fail if there is a high
probability that openings will be created during the
failure of the barrier.

•  Fire Spread
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1.5.4 Fire Scenario Probabilities and Occurrence Rates of Fires

Figure 1-22. Fire and Alarm System Input Dialog Box - Fire Occurrence Tab

Table 1-9. Fire and Alarm System Data - Fire Occurrence Statistics

Fire and Alarm System Statistical Data

Fire Incidence Rates Influences

Depending on the building occupation Type:

•  Apartment Buildings (fires / compartment / year)

•  Office Buildings (fires / 1000 m
2
 floor area / year)

The rate of occurrence of fire for apartment or office
buildings, given as the number of fires that could occur
per

•  Compartment per year for apartment buildings,

•  1000 m
2 
floor area per year for office buildings,

assuming the building occupants are

•  Awake

•  Asleep

when the fire starts.

•  Fire Scenario
Occurrence Probability

•  Expected Risk to Life

•  Fire Losses

•  Fire Cost Expectation
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Table 1-9 Continued

Fire and Alarm System Statistical Data

Probabilities of Occurrence for Fire Scenarios Influences
Probabilities for the following fire types:

•  Flashover Fires

•  Nonflashover Fires

•  Smouldering Fires

The probability that a fire, given that it occurs, will
become either

•  a fully developed flashover fire,

•  a nonflashover (flaming) fire or

•  a smouldering fire

for each text entry box.

•  Fire Scenario
Occurrence Probability

•  Expected Risk to Life

•  Fire Losses

•  Fire Cost Expectation
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1.6 FiRECAM Fire Department Characteristics and Statistical Data

FiRECAM also includes expert data on Fire Department characteristics.  This information can
be found by selecting the Fire Department tree root, as shown below in Figure 1-23.

Figure 1-23. Expert View - Fire Department

The Fire Department tree root data covers information in the following specific areas:

•  Times

•  Crew

•  Preparation

•  Travel

•  Setup
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1.6.1 Ideal Fire Department Action Times

The “Times” tab shown in Figure 1-24 presents the best possible idealized times for dispatch,
preparation, travel and setup.

Figure 1-24. Fire Department Input Dialog Box - Times Tab

Table 1-10 summarizes the definitions of these statistical “Time” data.

Table 1-10. Fire Department – Time Data

Fire Department Statistical Data – Times Tab

Ideal (Best Possible) Times Influences
Ideal Dispatch Time

The dispatch time the fire department takes, assuming
conditions are ideal.

Ideal Preparation Time

The preparation time the fire department takes,
assuming conditions are ideal.

•  Fire Department
Response Times
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Table 1-10 Continued

Fire Department Statistical Data – Times Tab

Ideal (Best Possible) Times Influences
Default Travel Time to Fire Site

The default time the fire department takes to arrive at a
fire site, assuming the fire department response is
not calculated; that is; the user chooses not to run a
Fire Department Response and Evaluation.

Default Setup Time

The default time the fire department takes to setup its
equipment, assuming the fire department response is
not calculated; that is; the user chooses not to run a
Fire Department Response and Evaluation.

•  Fire Department
Response Times
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1.6.2 Fire Crew and Resource Statistics

Factors regarding fire crews and resources are shown in the “Crew Information” tab (see Figure
1-25).

Figure 1-25. Fire Department Input Dialog Box - Crew Information Tab

Table 1-11 summarizes the definitions of these statistical data regarding fire department crews
and resources.

Table 1-11. Fire Department – Crew Data

Fire Department Statistical Data – Crew Information Tab

Crew Information Influences
Time factors for the following crew types:

•  Factor for Full-Time Firefighters

•  Factor for Part-Time Firefighters

•  Factor for Volunteer Firefighters

The effectiveness factor for

•  full-time firefighters,

•  part-time firefighters or

•  volunteer firefighters

expressed as a number between 0 and 1. This is usually
set to one (1) for full-time firefighters.  These factors are
used as weighing factors, where values less than one
(1) indicate less effectiveness.

•  Fire Department Action
and Effectiveness
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Table 1-11 Continued

Fire Department Statistical Data – Crew Information Tab

Crew Information Influences
Minimum Crew Size

The minimum crew size, in persons, that is required to
be considered effective; that is, what is the smallest
crew size for the firefighters to have any effect on the
fire in terms of extinguishment and rescue effectiveness.

•  Fire Department Action
and Effectiveness

Crew Size Differential

What is the difference, in persons, between the
minimum crew size defined above, and the maximum
allowable crew size for its overall effectiveness to have
no more impact on the fire?

•  Fire Department Action
and Effectiveness

Crew Information Factors for Available Resources Influences
Time factors for the following resources:

•  Back Up Resources

•  Physical Fitness of Firefighters

•  Condition of Firefighter’s Equipment

These factors are time dilation factors, which influence
the crew setup time.  A zero value means that there is
no effect, a positive value will stretch the required time.

Factor values for:

•  Good

•  Fair

•  Poor

•  Fire Department Action
and Effectiveness
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1.6.3 Site Preparation Statistics

Statistics on site preparation are shown in the “Preparation” tab (see Figure 1-26).

Figure 1-26. Fire Department Input Dialog Box - Preparation Tab

Table 1-12 summarizes the definitions of the site preparation statistical data.

Table 1-12. Fire Department – Preparation Data

Fire Department Statistical Data – Preparation Tab

Time Expansion Factors Influences
Dispatch Time Expansion Factor due to Concurrent
Calls

These factors are time dilation factors, which influence
the ideal crew dispatch time when concurrent calls to
the fire department must be considered.  A zero value
means that there is no effect, a positive value will stretch
the required time.

•  Fire Department
Response Times

Preparation Time Building Expansion Factor due to
Concurrent calls

These factors are time dilation factors, which influence
the ideal crew preparation time when concurrent calls
to the fire department must be considered. A zero value
means that there is no effect, a positive value will stretch
the required time.

•  Fire Department
Response Times



EXPERT TOOLS AND OPTIONS MANUAL

1-35

Table 1-12 Continued

Fire Department Statistical Data – Preparation Tab

Dispatch and Preparation Time Factors Influences
Time factors for the following firefighter characteristics:

•  Experience

•  Training Frequency

•  Local Knowledge

•  Availability of Resources

•  Explosion Potential

•  Building Collapse Potential

•  Hazardous Material Release

These factors are time dilation factors, which influence
the ideal crew preparation time.  A zero value means
that there is no effect, a positive value will stretch the
required time.

Factor values for:

•  Good

•  Fair

•  Poor

Communication System Factors

Time expansion factor for the setup time due to the
presence of

•  Central Alarm

•  PA System

•  Fire Department
Response Times
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Table 1-12 Continued

Fire Department Statistical Data – Preparation Tab

Dispatch and Preparation Time Factors Influences
Incident Notification

Factor values for:

•  Auto Alarm

•  911 Centre

•  Public Phone

Notification of Absent Firefighters

Factor values for:

•  Page System

•  Special Phone

•  PA System

•  Fire Department
Response Times
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1.6.4 Travel Statistics

FiRECAM also provides a set of travel statistics and travel time factors shown in the “Travel”
tab (see Figure 1-27).

Figure 1-27. Fire Department Input Dialog Box - Travel Tab

Table 1-13 provides a detailed description of travel statistics.

Table 1-13. Fire Department – Travel Data

Fire Department Statistical Data – Travel Tab

Travel Times Expansion  Factors Influences
Road Building Factor for Distance from building to Public
Road

Time expansion factor for the travel time when the
building is situated at some distance from the public
read or is not easily accessible.

•  Fire Department
Response Times
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Table 1-13 Continued

Fire Department Statistical Data – Travel Tab

Travel Time Factors Influences
Experience

Factor values for:

•  >= 2 years experience

•  < 2 years experience

•  Novice

Local Knowledge

Factor values for:

•  Very Good

•  Good

•  Poor

Street Layout and Arrangement

Factor values for:

•  Wide Streets

•  Average Streets

•  Narrow Streets

Curves and Intersections

Factor values for:

•  Low Curve Frequency

•  Medium Curve Frequency

•  High Curve Frequency

Traffic Volume

Factor values for:

•  Low Traffic

•  Medium Traffic

•  High Traffic

•  Fire Department
Response Times
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1.6.5 Setup Time Statistics

FiRECAM also provides a set of default setup times and statistics shown in the “Setup” tab (see
Figure 1-28).

Figure 1-28. Fire Department Input Dialog Box - Setup Tab

Table 1-14 provides a detailed description of fire department crew setup factors.

Table 1-14. Fire Department – Crew Setup Data

Fire Department Statistical Data – Setup Tab

Building Height Effectiveness Factors Influences
Building Height Factor:

•  Underground

•  1 to 3 Floors

•  4 to 6 Floors

•  7 to 13 Floors

•  More than 13 Floors

Factors that influence the setup time and rescue
effectiveness due to the height of the building.

•  Fire Department
Response Times

•  Firefighting Rescue
and Suppression
Effectiveness
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Table 1-14 Continued

Fire Department Statistical Data – Setup Tab

Installed Equipment Effectiveness Factors Influences
Time factors for the following equipment:

•  Direct Alarm Connection

•  Central Alarm

•  Sprinklers

•  Smoke Control Systems

•  Communication System

•  Emergency Power

•  Emergency Lighting

•  Fire Rated Elevators

•  Fire Hose Cabinets

•  Manual Fire Extinguishers

Effectiveness reduction factors for the presence or
absence of installed equipment.  Factor values for:

•  Device(s) not Installed

•  Device(s) Installed

•  Fire Department
Response Times

•  Firefighting Rescue
and Suppression
Effectiveness
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1.7 FiRECAM Numerical Control

In FiRECAM, the Expert Data provides a tree root option for Numerical Control that is used to
control flame spread calculations (see Figure 1-29).

Figure 1-29. Expert View - Numerical Control

Figure 1-30 displays the options available for fire spread probability calculations, and
Table 1-15 provides a description of the fire spread probability calculation parameters.

Figure 1-30. Fire Spread Parameters Input Dialog Box
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Table 1-15. Fire Spread Parameter Data

Numerical Control

Fire Spread Probability Calculation Control Influences
Combine Elevators to Reduce Fire Spread Path
Calculations

This option allows FiRECAM to combine elevator shafts
into a single fire spread path, to allow more efficient fire
path searching for tall buildings.

Combine Service Ducts to Reduce Fire Spread Path
Calculations

This option allows FiRECAM to combine service duct
shafts into a single fire spread path, to allow more
efficient fire path searching for tall buildings.

Fire Spread Accuracy Factor (Minimum Tolerance)

The minimum allowable probability value for fire spread
through a set of barrier locations, before it is assumed
the probability of fire spread value becomes
insignificant.

Maximum Allowable Hops for Location to Location Fire
Spread

The total number of hops (barriers) a fire can cross to
spread from a given location to a destination location
before the fire spread ceases.

•  Fire Spread



EXPERT TOOLS AND OPTIONS MANUAL

1-43

Figure 1-31. Fire Spread Parameters Input Dialog Box

Table 1-16. Evacuation Parameter Data

Numerical Control

Evacuation Calculation Control Influences
Stop Occupant Evacuation when...

•  Stairwells become blocked by smoke

•  All responding  occupants have left

Evacuation stops when one of these conditions has
been satisfied

Maximum Allowable time for building evacuation

The maximum time allowed for evacuation, assuming
none of the above conditions could be satisfied.

This time limit is typically used to prevent infinite run
times.

•  Evacuation
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2 FiRECAM EXPERT PASSWORD UTILITY

WARNING

THIS UTILITY IS TO BE USED BY EXPERIENCED FiRECAM USERS AND THE FIRE RISK
MANAGEMENT PROGRAM FOR VERIFICATION AND TESTING PURPOSES.  IT IS
INCLUDED FOR COMPLETENESS, BUT THE FIRE RISK MANAGEMENT PROGRAM
CANNOT ASSUME RESPONSIBILITY OR BE HELD LIABLE FOR IMPROPER USE AND
MODIFICATION OF THE FiRECAM EXPERT DATABASE CONTENTS.  CAUTION IS
ADVISED WHEN INSPECTING OR MODIFYING THE FiRECAM EXPERT DATABASE.

The FiRECAM Expert Password (FIREPASS.EXE) Utility is used to manage access to
FiRECAM’s expert database.  Access is allowed to users who have a valid user name and
password to enter FiRECAM’s Expert Mode.  FiRECAM will always prompt a user for his user
name and password before allowing entry into expert mode.

By using FIREPASS, an expert user or administrator may

•  Add users to the Expert User List,

•  Remove an existing user,

•  Modify an existing user’s password.

These operations are described in further detail in the following sections.



EXPERT TOOLS AND OPTIONS MANUAL

2-2

2.1 Starting FiREPASS

To Start the FiRECAM Expert Password Utility

•  Go to the FiRECAM Program Group

•  Double-click the FiREPASS icon to start the program, or choose Start -> Program Files ->
FiRECAM -> FiREPASS from the Windows Start button.

•  The FiREPASS Main Screen shown below will then appear, as in Figure 2-1:

 Figure 2-1. FiREPASS Main Startup Screen
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2.2 Adding a User to the Expert User List

To add a new user to the FiRECAM expert user’s list:

•  Choose the Add New User from the User menu below

Figure 2-2. Adding a New User

•  A password input dialog for the user’s name and password will then appear, as shown in
Figure 2-3:

Figure 2-3. Add New User Dialog

•  Type a user name in the User Name: text box.

•  Type the user’s desired password in the Password: text box, and retype the password in
the Confirm: text box.

•  Click the OK button on the password input dialog box.

The user name and password will then be entered in the FiRECAM expert user and password
list.
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2.3 Modifying a User in the Expert User List

To modify an existing user password:

•  Highlight the user to modify in the FiRECAM passwords list box by clicking on the desired
user’s name list.  For example, Figure 2-4 below shows user ‘t’ selected.

Figure 2-4. Selecting a User from the List

•  Choose the Change User Password from the User menu

Figure 2-5. Changing an Existing User Password
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•  A password input dialog for the user’s old and new passwords will then appear:

Figure 2-6. Password Change Dialog

•  Type the user’s old password in the Old Password: text box.

•  Type the user’s new password in the New Password: text box, and retype the new
password in the Confirm: text box.

•  Click the OK button on the password input dialog box.

The user’s new password will then be entered in the password list.
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2.4 Removing a User from the Expert User List

To remove a user from FiRECAM’s Expert User List:

•  Highlight the user to remove in the FiRECAM passwords list box by clicking on the desired
entry.  For example, Figure 2-7 below shows user ‘t’ selected.

Figure 2-7. Selecting a User from the List

•  Choose the Remove User from the User menu.

Figure 2-8. Removing an Existing User

•  A confirmation dialog will then appear to verify the user choice.

Figure 2-9. Remove Confirmation Dialog
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•  Click the Yes button on the confirmation dialog box.  The user will be deleted.

The user will then be removed from the Expert user list, and the User list will be updated.
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2.5 Getting Help

FiREPASS has online help available.  To access FiREPASS Help, choose FiREPASS Help
from the Help menu, as shown below

There is also an About FiREPASS… splash screen available which provides some feedback
on system information. Selecting this option from the Help menu will display this splash screen
as shown in  Figure 2-11 and Table 2-1 below:

Figure 2-10. Invoking FiREPASS Help and About FiREPASS

Figure 2-11. About FiREPASS Screen
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Table 2-1. Computer System Information

Computer Resources

Windows Version Windows Version

Total Physical Memory Total installed RAM in the computer system in KB

Available Physical Memory Available free RAM in the computer system in KB

Total Virtual Memory Total virtual memory available (includes RAM and
paging file) in KB

Total Disk Space Total disk space in KB on drive C:

Available Disk Space Available disk space in KB on drive C:

% Used Disk Space % of used disk space on drive C:
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3 FiRECAM STUCTURED STORAGE OUTPUT FILE BROWSER

WARNING

THIS UTILITY IS TO BE USED BY EXPERIENCED FiRECAM USERS AND THE FIRE RISK
MANAGEMENT PROGRAM FOR VERIFICATION AND TESTING PURPOSES.  IT IS
INCLUDED FOR COMPLETENESS, BUT THE FIRE RISK MANAGEMENT PROGRAM
CANNOT ASSUME RESPONSIBILITY OR BE HELD LIABLE FOR IMPROPER USE OF THIS
UTILITY.

The FiRECAM Structured Storage Browser (FIREBROWSE.EXE) is used to browse through
the contents of a FiRECAM output file.  After a run, FiRECAM creates an output file, which
contains the results in an internal folder and storage-structured format.

A FiRECAM output file contains the results of a run in an internal structure that mimics the
organization of a disk's file system in a single file.  This structure, called Structured Storage, is
based on a new standardized technique for structuring blocks of data within the confines of a
single file and is implemented as part of the Object Linking and Embedding (OLE) subsystem.
In a Structured Storage file, blocks of data within a file are organized just as files are organized
on a drive -- in a hierarchical structure. The storage elements analogous to directories are
called Storages and those analogous to files are called Streams.

The next sections describe the use of the FiRECAM Structured Storage Browser.

3.1 Starting FiREBrowse

To Start the FiRECAM Structured Storage File Browser

•  Go to the FiRECAM Program Group

•  Double-click the FiREBrowse icon to start the program, or choose Start -> Program Files -
> FiRECAM -> FiREBrowse from the Windows Start button.

•  The FiREBrowse Main Screen shown below will then appear, as in Figure 3-1.  The
screen is organized in two main panes:

♦  The left-hand side is a tree view that mimics the look of a Windows Explorer view
showing the internal hierarchical layout of the file.

♦  The right-hand pane shows information about a selected storage, as well as the
contents of a selected stream.
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 Figure 3-1. FiREBrowse Main Startup Screen - No Opened File

3.2 Viewing a FiRECAM Structured Storage Output File

To view the contents of a FiRECAM output file, select the Open File from the File menu as
shown below. An Open File... dialog will appear with the default file extension for a FiRECAM
output file (STG).  This file contains the corresponding output data for a FiRECAM input file
(with extension FCI).   The file's contents will then be loaded and displayed in a hierarchical tree
view structure for quick browsing.

Figure 3-2. FiREBrowse File Open Menu and File Open Dialog
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Figure 3-3.  FiREBrowse Showing Structure and Contents of Opened File

Table 3-1. Storage and Stream Icons

Icon Type Description

Storage

A folder-like data structure that contains other storages
or streams.  The contents of a storage is a directory of
its sub-storages and streams in a hierarchical structure

Stream

A data stream that contains a block of data stored as a
single non-seperable entity (stream).  A stream is
represented by a Visual Basic variant data type that
saves information about the data's type (as in integer,
single or string) as well as a copy of the data itself.
Strings and arrays of data can also be saved as a single
block.
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3.2.1 Viewing a Storage

To view the contents of a storage, select one of the folder-like images from the tree view list in
the left-hand pane of the main windows, as shown below:

Figure 3-4. Selecting and viewing the Contents of a Storage

When a storage is selected, the right-hand pane lists information about the selected storage
and its contents.  The information listed for a storage includes:

Table 3-2. Storage Contents and Values

Storage Info Value

•  Storage Name The name of the storage element

•  Storage Path The full path of the storage from the topmost root
storage (the highest upper level), including parent
storages.

•  Parent Storage The name of this storage's parent storage

•  Sub Storage Count Count of child storages (sub-storages) this storage
contains

•  Stream Count Count of the streams contained in this storage
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3.2.2 Viewing a Stream

To view the contents of a stream, select one of the page-like images from the tree view list in
the left-hand pane of the main windows, as shown below:

Figure 3-5. Selecting and viewing the Contents of a Stream

When a stream is selected, the right-hand pane lists information about the selected stream and
its contents.  The information listed for a stream includes:

Table 3-3. Stream Contents and Values

Storage Info Value

•  Stream Name The name of the stream element

•  Stream Path The full path of the storage from the topmost root
storage (the highest upper level), including parent
storages.

•  Parent Storage The name of this stream's parent storage
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Table 3-3 Continued

The variable type contained in this stream,  from one of
the following types:

•  Variable Type

•  Empty

•  Null

•  Integer

•  Long Integer

•  Single Precision

•  Double Precision

•  Currency

•  Date

•  String

•  General Object

•  Error Object

•  Boolean

•  Variant

•  Data Access Object

•  Decimal

•  Byte

The length in bytes of the individual storage elements,
whether as a single value or as part of an array (see
below)

•  Empty 16 Bytes

•  Null 16 Bytes

•  Integer 2 Bytes

•  Long Integer 4 Bytes

•  Single Precision 4 Bytes

•  Double Precision 8 Bytes

•  Currency 8 Bytes

•  Date 8 Bytes

•  String Length of String in Bytes

•  General Object 16 Bytes

•  Error Object 16 Bytes

•  Boolean 2 Bytes

•  Variant 16 Bytes

•  Data Access Object 16 Bytes

•  Decimal 8 Bytes

•  Byte 1 Byte

•  Length

•  Is Array? Indicates whether the stream contains an array of values
rather than a scalar (single value)

•  Number of Elements For arrays, this is the total number of elements in the
array.  For scalars, this value is not applicable (N/A)

•  Lower Bound For arrays, this is the lower index bound value of the
elements in the array.  For scalars, this value is not
applicable (N/A)

•  Upper Bound For arrays, this is the upper index bound value of the
elements in the array.  For scalars, this value is not
applicable (N/A)

•  Value(s) This the value of the contents of the stream.  For arrays,
the values are listed as an ordered list of the values of
each element, including the value of their indices.
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3.3 Getting Help

FiREBrowse has online help available.  To access FiREPASS Help, choose FiREBrowse Help
from the Help menu, as shown below

Also available is an About FiREBROWSE splash screen which provides some feedback on
system information.

Figure 3-6. Invoking FiREBrowse Help and About FiREBrowse

Selecting the About FIREBrowse will display this splash screen as shown below:

Figure 3-7. About FiREBrowse

Table 3-4. Computer System Information

Computer Resources

Windows Version Windows Version
Total Physical Memory Total installed RAM in the computer system in KB
Available Physical Memory Available free RAM in the computer system in KB
Total Virtual Memory Total virtual memory available (includes RAM and

paging file) in KB
Total Disk Space Total disk space in KB on drive C:
Available Disk Space Available disk space in KB on drive C:
% Used Disk Space % of used disk space on drive C:
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4 FIRECAM EXPERT DEBUGGING OPTIONS

WARNING

THIS UTILITY IS TO BE USED BY EXPERIENCED FiRECAM USERS AND THE FIRE RISK
MANAGEMENT PROGRAM FOR VERIFICATION AND TESTING PURPOSES.  IT IS
INCLUDED FOR COMPLETENESS, BUT THE FIRE RISK MANAGEMENT PROGRAM
CANNOT ASSUME RESPONSIBILITY OR BE HELD LIABLE FOR IMPROPER USE AND
MODIFICATION OF THE FiRECAM EXPERT DATABASE CONTENTS.  CAUTION IS
ADVISED WHEN INSPECTING OR MODIFYING THE FiRECAM EXPERT DATABASE.

4.1 Viewing Expert Data

In order to view FiRECAM’s expert data, the user has to have entered a valid username and
password at the FiRECAM Expert Password prompt. Once this process is successful, the
Expert Menu’s submenu “Edit FiRECAM’s Master Expert Data” can be accessed (see Figure
4-1.)

Figure 4-1. Expert Mode Menu

In addition, the user can also view the expert input data when an input report is viewed. An
excel worksheet report is displayed as shown in Figure 4-2.

Statistical information and factors used by the Expert Data cover the following areas:

•  Fire Rates and Occurrences

•  Occupant Statistics

•  Protection System Statistics

•  Numerical Control

•  Fire Department Statistics

Figure 4-2 displays the Expert Data tree root that will present the expert input data used in the

form of an Excel� spreadsheet report.
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Figure 4-2. Expert Data Spreadsheet
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4.1.1 Probabilities and Rates of Natural Fire Occurrence

Table 4-1 presents the parameters available for fire scenario occurrences and rates of fire
occurrences, while Table 4-2 displays a spreadsheet fragment of these parameters.

Table 4-1. Probabilities and Rates of Natural Fire Occurrence

Probability of Scenario Occurrence

•  Probability of occurrence for flashover fires

•  Probability of occurrence for non-flashover fires

•  Probability of occurrence for smouldering fires

Rates of Fire Occurrences

•  Rate of fire occurrence when occupants are awake

•  Rate of fire occurrence when occupants are asleep

Table 4-2. Typical Expert Data Spreadsheet Fragment with Probabilities and Rates of
Natural Fire Occurrence

Probability of Fire Scenario Occurrence

• Flashover fires 0.2420

• Non-flashover fires 0.5350

• Smouldering fires 0.2230

Rates of Fire Occurrences

• When occupants are awake 0.00768

• When occupants are asleep 0.00000
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4.1.2 Occupant Statistical Data

Table 4-3 presents the parameters available for occupant perception factors; occupant action
factors and occupant travel speeds, while Table 4-4 displays a spreadsheet fragment of these
parameters.

Table 4-3. Probabilities of Perception and Action and Occupant Speeds

Occupant Risk Factors

•  Perception

Occupant Risk Factors

•  Perceive

•  Warn Occupants

•  Local Alarm

•  Central Alarm

•  Voice Alarm

•  Fire Department

Occupant Travel Speeds

•  Emergency Horizontal

•  Emergency Stair (Up)

•  Emergency Stair (Down)

•  Normal Horizontal

•  Normal Stair (Up)

•  Normal Stair (Down)

Table 4-4. Typical Expert Data Spreadsheet Fragment

Interpretation Time Delays

• Reasonable response
probability

sec 50

• Fair response probability sec 98

• Little response probability sec 250

Probability of Calling Fire Department by…

• Occupants in fire origin compartment 0.9000

• Occupants on fire origin floor 0.5000

• Occupants on non fire origin
floors

0.0200
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4.1.3 Protection System and Smoke Control Statistical Data

Table 4-5 presents the probability parameters available for sensor operation, smoke and
sprinkler control and barrier failure, while Table 4-6 displays a spreadsheet fragment of these
probability parameters.

Table 4-5. Protection System Statistics

Sensor Operation Probability

•  Local smoke alarm activation probability

•  Smoke detector activation probability

•  Heat detector activation probability

•  Reliability of central alarm system (control panels)

Smoke and Sprinkler Control

•  Probability that smoke ventilation system is working

•  Probability that stair pressurization system is working

•  Reliability of automatic sprinkler system

•  Effectiveness of automatic sprinkler system

Probability of Barrier Failures

•  Failure probability between open stairs to open stairs (up)

•  Failure probability between open stairs to open stairs (down)

Table 4-6. Typical Expert Data Spreadsheet Fragment with Protection System Statistics

Sensor Activation Probabilities

Local smoke alarm 0.8000

Smoke detector 0.8000

Heat detector 0.8000

Reliability of central alarm system
(control panels)

0.8000

Smoke and Sprinkler Control

Probability that smoke ventilation
system is working

0.8000

Probability that stair pressurization
system is working

0.8000

Reliability of automatic sprinkler system 0.9000

Effectiveness of automatic sprinkler
system

0.9000

Probability of Barrier Failures

Open stairs to open stairs (up) 0.9000

Open stairs to open stairs (down) 0.1000
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Table 4-7 presents the probability parameters available for door conditions, while Table 4-8
displays a spreadsheet fragment of these probability parameters.

Table 4-7. Door Statistics

Probability of Doors

•  Probability of door from fire compartment to corridor on any level being open

•  Probability of door leading from corridor to stair shaft on any level being open

•  Probability of door leading from non-fire compartment to corridor on any level being open

Table 4-8. Typical Expert Data Spreadsheet Fragment with Door Statistics

Probability of Open Doors

From fire compartment to corridor on
any level

0.9000

From corridor to stair shaft on any level 0.1000

From non-fire compartment to corridor
on any level

0.9000
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4.1.4 Numerical Control Data

Table 4-9 presents the parameters available for barrier failure and the failure correction factors
used by FiRECAM’s Expert Data, while Table 4-10 displays a spreadsheet fragment of these
parameters and factors.

Table 4-9. Numerical Model Parameters

Barrier Failure Parameters

•  Standard deviation/mean fire rating for the construction element

•  Average thermal inertia value of building materials

•  Standard deviation of the inventory fire load density

•  Inventory mean load fire density

Failure Correction Factors

•  Correction for walls and floors made of plasterboard

•  Correction for inadvertent openings of wall and floor

•  Fire Spread Control

•  Tolerance limit for probability of fire spread calculations

Table 4-10. Typical Expert Data Spreadsheet Fragment with Numerical Model Parameters

Fire Spread Control

Combine stairs No

Combine elevators No

Combine service ducts No

Tolerance limit for probability of fire
spread calculations

0.001

Maximum path length (hops) for fire
spread calculations

5

Evacuation Control

Stop evacuation when… Stairs
blocked by

smoke

Maximum allowed time for
evacuation building

sec 90
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4.1.5 Fire Department Statistical Data

Table 4-11 presents the default setup and response time parameters used by FiRECAM’s
Expert Data, while Table 4-12 displays a spreadsheet fragment of these time parameters.

Table 4-11. Fire Department Statistics

Default Setup and Response

•  Dispatch Time

•  Preparation Time

•  Response Time

•  Travel Time

•  Setup Time

Table 4-12. Typical Expert Data Spreadsheet Fragment with Fire Department Statistics

Ideal Setup and Response Times

Dispatch Time sec 50

Preparation Time sec 70

Response Time sec 120

Travel Time sec 50

Setup Time sec 70

Table 4-13 presents the dispatch and preparation time factors used by FiRECAM’s Expert Data,
while Table 4-14 displays a spreadsheet fragment of these time factors.

Table 4-13. Fire Department Dispatch and Preparation Data

Dispatch Time Factors

•  Experience

•  Training

•  Local Knowledge

•  Availability

•  Potential for Explosions

•  Potential for Building Collapse

•  Potential for Hazardous Material

Preparation Time Factors

•  Experience

•  Training

•  Local Knowledge

•  Availability

•  Potential for Explosions

•  Potential for Building Collapse

•  Potential for Hazardous Material
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Table 4-14. Typical Expert Data Spreadsheet Fragment with Fire Department Dispatch
and Preparation Data

Dispatch Time Expansion Factors

Experience > 2 Years 0.0000

< 2 Years 0.0050

Novice 0.0100

Training High 0.0000

Medium 0.0050

Low 0.0100

Local Knowledge Very Good 0.0000

Good 0.0050

Poor 0.0100

Availability Good 0.0000

Medium 0.0050

Poor 0.0100

Potential for Explosions Low 0.0000

Medium 0.0050

High 0.0100

Potential for Building Collapse Low 0.0000

Medium 0.0050

High 0.0100

Potential for Hazardous Material Low 0.0000

Medium 0.0050

High 0.0100

Preparation Time Expansion Factors

Experience > 2 Years 0.0000

< 2 Years 0.0050

Novice 0.0100

Training High 0.0000

Medium 0.0050

Low 0.0100

Local Knowledge Very Good 0.0000

Good 0.0050

Poor 0.0100

Availability Good 0.0000

Medium 0.0050

Poor 0.0100

Potential for Explosions Low 0.0000

Medium 0.0050

High 0.0100

Potential for Building Collapse Low 0.0000

Medium 0.0050

High 0.0100

Potential for Hazardous Material Low 0.0000

Medium 0.0050

High 0.0100
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Table 4-15 presents the travel time factors used by FiRECAM’s Expert Data, while Table 4-16
displays a spreadsheet fragment of these time factors.

Table 4-15. Travel and Route Condition Factors

Travel Time Factors

•  Communication Systems

•  Incident Notification

•  Notification of Absent Firefighters

•  Experience

•  Local Knowledge

•  Street Arrangements

•  Curves and Intersections

•  Traffic Volume

Table 4-16. Typical Expert Data Spreadsheet Fragment with Travel and Route Condition
Factors

Travel Time Expansion Factors

Communication Systems Central
Alarm

0.0000

PA System 0.1000

(not used) 0.0000

Incident Notification Auto Alarm 0.0000

911 Centre 0.5000

Public Phone 1.0000

Notification of Absent Firefighters Page System 0.0000

Special
Phone

0.5000

PA System 1.0000

Experience > 2 Years 0.0000

< 2 Years 0.0250

Novice 0.0500

Local Knowledge Very Good 0.0000

Good 0.0250

Poor 0.0500

Street Arrangements Wide 0.0000

Average 0.0250

Narrow 0.0500

Curves and Intersections Low 0.0000

Medium 0.0500

High 0.1000

Traffic Volume Low 0.0000

Medium 0.1000

High 0.2000



EXPERT TOOLS AND OPTIONS MANUAL

4-11

Table 4-17 presents the equipment factors used by FiRECAM’s Expert Data, while Table 4-18
displays a spreadsheet fragment of these equipment factors.

Table 4-17. Equipment Factors

Equipment Description

•  Direct Alarm Connection

•  Central Alarm

•  Sprinklers

•  Smoke Control System

•  Communication System

•  Emergency Power

•  Emergency Lighting

•  Fire Elevators

•  Hose Cabinets

•  Manual Fire Extinguishers

Table 4-18. Typical Expert Data Spreadsheet Fragment with Equipment Factors

Equipment Installations Installed Not Installed

Direct Alarm Connection 0.0200 0.0000

Central Alarm 0.0100 0.0000

Sprinklers 0.0200 0.0000

Smoke Control System 0.0100 0.0000

Communication System 0.0100 0.0000

Emergency Power 0.0050 0.0000

Emergency Lighting 0.0100 0.0000

Fire Elevators 0.0050 0.0000

Hose Cabinets 0.0100 0.0000

Manual Fire Extinguishers 0.0100 0.0000
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Table 4-19 presents crew and building height factors used by FiRECAM’s Expert Data, while
Table 4-20 displays a spreadsheet fragment of these factors.

Table 4-19. Crew and Building Factors

Crew Description

•  Factor for Full-Time Firefighters

•  Factor for Part-Time Firefighters

•  Factor for Volunteer Firefighters

•  Minimum Crew Size

•  Crew Size Differential

Building Height

•  Underground

•  1 to 3 Floors

•  4 to 6 Floors

•  7 to 13 Floors

•  > 13 Floors

Table 4-20. Typical Expert Data Spreadsheet Fragment with Crew and Building Factors

Crew Description

Factor for Full Time Firefighters 1.0000

Factor for Part Time Firefighters 0.9000

Factor for Volunteer Firefighters 0.8500

Minimum Crew Size 5

Crew Size Differential 2

Building Height

Underground 0.7000

1 to 3 Floors 1.0000

4 to 6 Floors 0.9000

7 to 13 Floors 0.7000

> 13 Floors 0.4000
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4.2 Fire Scenario and FiRECAM Model Selection

For expert users, FiRECAM allows selective execution of FiRECAM models, as well as the fire
scenarios.  To select FiRECAM fire scenarios and models, choose the Select Models for
Debug from the Expert menu as shown in Figure 4-3.

Figure 4-3. FiRECAM Expert Menu - Scenario and Models

Fire scenarios can be selected by using the FiRECAM model selection fire scenarios tab, as
shown in Figure 4-4.

Table 4-21 summarizes FiRECAM’s model execution for different fire scenarios and occupant
states.

Table 4-21 FiRECAM Model Scenario and Occupant State Execution Lists

Scenario B
E

V
M

F
D

R
M

E
C

M
D

B
E

F
M

D
F

M
D

F
G

M
D

F
D

A
M

O
C

R
M

S
M

M
D

E
V

M
D

F
D

E
M

F
S

P
M

E
N

D
M

E
R

L
M

P
L

M
D

F
C

E
D

Run Once Only
1

���� ���� ���� ���� ����

FL/DO - Flashover fire, fire compartment door

open
���� ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

FL/DC - Flashover fire, fire compartment door

closed
���� ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

NF/DO - Non-flashover fire, fire compartment door

open
���� ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

NF/DC - Non-flashover fire, fire compartment door

closed
���� ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

SM/DO - Smouldering fire, fire compartment door

open
���� ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

SM/DC - Smouldering fire, fire compartment door

closed
���� ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

Occupants Awake
2

���� ���� ���� ���� ���� ���� ���� ���� ���� ����

Occupants Asleep ���� ���� ���� ���� ���� ���� ����

Each Fire Origin Floor
3

���� ���� ���� ���� ���� ����

                                               
1
 Some models are scenario independent, therefore their output is computed once only.

2
 For office occupancy buildings, occupants are always assumed to be awake; occupants asleep scenario

is not run.
3
 Fire floor calculations are done internally.
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Figure 4-4. FiRECAM Debug Selection - Fire Scenarios

Figure 4-4 displays FiRECAM’s model debugging options according to different fire scenarios.

Table 4-22. FiRECAM Model Debugging Options – Fire Scenarios

Model Debugging Options

Fire Scenarios Fire Compartment Door State
Door Open

Flashover Fire
Door Closed
Door Open

Nonflashover Fire
Door Closed
Door Open

Smouldering Fire
Door Closed

FiRECAM models can also be selected by using the FiRECAM model selection tab, as shown in
Figure 4-5.

Figure 4-5. FiRECAM Debug Selection - Stand-alone Models

Figure 4-6. FiRECAM Debug Selection - Dependent Models
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Table 4-23 displays FiRECAM’s model debugging options according to FiRECAM models and
submodels.

Table 4-23. FiRECAM Model Debugging Options – FiRECAM Models

Model Debugging Options

Standalone Submodels
Short
Name

Description

Building Evaluation BEVM Building Evaluation Model

Fire Department FDRM Fire Department Response Model

Fire Cost Expectation FCED Fire Cost Expectation Model

Economic ECMD Economic Model

Failure Probability BEFM Boundary Element Failure Model

Dependent Submodels
Short
Name

Description

Occupant Response OCRM Occupant Response Model

Evacuation EVMD Evacuation Model

Fire Department Action FDAM Fire Department Action Model

Smoke Movement SMMD Smoke Movement Model

Flame Spread FSPM Fire Spread Model

Expected Deaths ENDM Expected Number Of Deaths
Model

Expected Risk to Life ERLM Expected Risk To Life Model

Property Loss PLMD Property Loss Model

Fire Growth FGMD Fire Growth Model

Table 4-24. Model Execution Sequence Dependency Matrix
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BEVM ∨∨∨ ∨
FDRM ∨∨∨ ∨
ECMD ∨∨∨ ∨
BEFM ∨∨∨ ∨
DFMD ∨∨∨ ∨
FGMD ∨∨∨ ∨
FDAM ∨∨∨ ∨ ���� ����

OCRM ∨∨∨ ∨ ���� ���� ����

SMMD ∨∨∨ ∨ ���� ���� ���� ����

EVMD ∨∨∨ ∨ ���� ���� ���� ���� ����

FSPM ∨∨∨ ∨ ���� ���� ���� ����

ENDM ∨∨∨ ∨ ���� ���� ���� ���� ���� ���� ���� ����

PLMD ∨∨∨ ∨ ���� ���� ���� ���� ���� ���� ���� ���� ����

ERLM ∨∨∨ ∨ ���� ���� ���� ���� ���� ���� ���� ���� ����

FCED ∨∨∨ ∨ ���� ���� ���� ���� ���� ���� ���� ���� ���� ����

∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨ ∨∨

Model
Output

B
E

V
M

F
D

R
M

E
C

M
D

B
E

F
M

D
F

M
D

F
G

M
D

F
D

A
M

O
C

R
M

S
M

M
D

E
V

M
D

F
S

P
M

E
N

D
M

P
L

M
D

E
R

L
M

F
C

E
D
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Figure 4-7 FiRECAM Model Execution Sequence
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